
 

 

 

SESSION 1 
A Trip to Egypt 
In this session, students begin their exciting adventure. A secret tomb has been 

uncovered in the Valley of the Kings. As Egyptologists, they have been called 

to the site to help identify the mummy. Their virtual trip through Egypt to the 

Valley of the Kings has them sail down the Nile River, eat Egyptian food, and 

take a rest at the foot of a famous temple. The events are recorded in their 

personal diary. This session offers students an introduction to Egyptian life and 

their ancient beliefs. 

Assignment 1: About Egypt 

Assignment 2: The Journey to the Valley of the Kings 

Assignment 3: The Diary 

 

Session 1 Skill Review: Online Picture Scavenger Hunt 

Session 1 Extension Activity: Make Your Own Mummy 

 

  

Each TechnoKids project consists of 
6 sessions, which are divided into 
separate assignments.  
An assignment is an activity that 
takes about 20 minutes to complete. 

SAMPLE

TechnoKids Inc.
Typewritten Text
Learn more about TechnoMummy

http://www.technokids.com/Store/Elementary-School/TechnoMummy/ancient-egypt-for-kids.aspx
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Session 1: A Trip to Egypt 

Getting Started 

Overview 

In this session, students begin their exciting adventure. A secret tomb has been uncovered in the 

Valley of the Kings. As Egyptologists, they have been called to the site to help identify the mummy. 

Their virtual trip through Egypt to the Valley of the Kings has them sail down the Nile River, eat 

Egyptian food, and take a rest at the foot of a famous temple. The events are recorded in their 

personal diary. This session offers students an introduction to Egyptian life and their ancient beliefs. 

 

Materials 

 Microsoft Office Word 2013 

 Flashcards (Optional) 

o Word 2013 Home Tab 

o Internet Explorer 

 Mummy Folder 

o Diary template 

 Diary sample 

 Glyph fonts 

 Handouts 

o Legend of Fonts 

o Acceptable Use Policy (AUP) (Optional) 

 TechnoMummy Favorites 

 Workbook Files - Individual PDF Files for Assignments, Reviews, Skill Reviews, and Extension 

Activities (Optional) 

 Session 1 Skill Review: Online Picture Scavenger Hunt (Optional) 

o Egypt sample 

 

Teacher Preparation  

(Refer to the Preparing to Teach section of this guide for instructions.) 

 Make the Mummy folder available to students.  

 Determine a location for students to save their work during this project. 

 Install the Glyph fonts. 

 Print handouts. 

 Make the TechnoMummy Favorites available to students. 

 (Optional) Print the flashcards listed in the materials list for this session.  

 Ensure your students/parents/guardians have read & signed the Internet AUP before 

going online. 

  

For every session, the Teacher Guide 
features:  
 an introduction with a materials list 
 preparation advice 
 teaching strategies 
 lesson plans for each assignment 
 learning objectives for the session 

SAMPLE
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Teaching Strategy 

In this project, students become Egyptologists. Explain scenario to students. 

 

In this project, you assume the role of an Egyptologist. A 

secret tomb has been uncovered in the Valley of the 

Kings. As experts in the field, you must travel to Egypt to 

help uncover the identity of the mummy. By studying the 

artifacts in the tomb, clues are revealed about the person 

and their life in ancient Egypt.  

 

 

Assignment 1 About Egypt 

 

In this assignment, facts about Egyptian life and beliefs are provided to students. This provides 

the background information they need for the project. It may be helpful to supply additional 

books and other resources for students to study and learn about the topic.  

 

 

Assignment 2 The Journey to the Valley of the Kings 

 

In this assignment, students take a virtual trip to the Valley of the Kings. By writing about 'trip' 

events in a diary, students acquire facts about Egyptian life and beliefs. The template used for 

this activity requires that students use the facts in Assignment 1 to complete sentences. These 

facts are about the geography, climate, and agriculture in Egypt today. It also includes facts 

about ancient Egyptians including dress, religious beliefs, and mummification. In addition, the 

template offers space for pictures to be pasted into the diary. These images are acquired using 

the Internet and they offer students a visual image of Egypt. 

 

 

Assignment 3 The Diary 

 

In this assignment, students format the appearance of their diary entries. By changing the font 

appearance and adjusting the text wrap for the pictures, the diary is made to look eye-

catching. Hieroglyphics are added using Glyph fonts. You may wish to distribute the handout 

Legend of Fonts to aid students when adding hieroglyphs. These skills will be needed again in 

Session 6, when students report on their findings. Optionally, this file is available in PDF format 

from the Mummy folder for viewing digitally. 

 

Upon completion of this assignment, students print their work. Establish a printing procedure for 

each class to follow. For example: 

 

 Avoid crowding around the printer  

Assign one person to retrieve documents from the print tray. 

 

 Consider readiness to print  

Prepare a checklist to avoid incomplete work being added to the print queue. 

 

 Timing 

Occasionally a session may end before all printing is complete. Inform the following 

class/teacher of impending documents from the printer and arrange to collect them 

at a later time. 

 

 

  

SAMPLE
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Lesson Plan 

Assignment 1 - About Egypt 

 Read facts about Egypt today. 

 Read facts about ancient Egypt. 

 

Assignment 2 - The Journey to the Valley of the Kings 

 Open the Diary template. 

 Discuss the parts of the Diary template including the sections where facts and pictures 

are added. 

 Add facts to the diary entries using the information listed in Assignment 1. 

 Add pictures to the diary entries by copying images from the internet and pasting them 

into the document. 

 Complete the diary entries. Make sure the sentences are complete. 

 Save the diary into a student folder. 

 Close Internet Explorer and Microsoft Word. 

 

Assignment 3 - The Diary 

 Open the saved Diary document. 

 Format the font, font size, and font style of text. 

 Format the text wrapping of the pictures to allow the words to flow around the images. 

 Add hieroglyphs to the diary. 

 Save the changes. 

 Close Microsoft Word. 

  The Lesson Plan lists 
the individual steps in 
each assignment. 

SAMPLE



TECHNOMUMMY 

 

1-4  TECHNOKIDS INC. 

Learning Objectives 

Below is a list of the learning objectives for this session. Students should be able to complete 

each task independently. 

 

Content Knowledge: 

 demonstrate an understanding of ancient Egyptian life including dress, class structure, 

shelter, and beliefs 

 demonstrate an understanding of the climate, geography, and agriculture of modern 

Egypt 

 

Technical Skills: 

 

Operating Environment 

 open and close a program 

 save a document 

 print a document 

 open a document 

 use the mouse to position the cursor in a document 

 use the mouse to copy and paste an item on the clipboard 

 

Applied Technology 

 write diary entries about the journey to the Valley of the Kings 

 

Word Processing 

 add text 

 format the font, font size, and font style of text 

 format the text wrapping of a picture 

 paste a picture into a Microsoft Word document 

 resize and reposition images 

 select a word, line, or an entire document 

 

Telecommunications 

 use a search engine and key words to locate pictures 

 copy and picture from a web page 

 

 

 

 Learning Objectives are 
specified for each of the six 
sessions in the project.  
A checklist of all objectives 
is provided at the end of 
the project in Session 7. SAMPLE
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Assignment 1: About Egypt 
 

 

Egypt Today 

Sometimes when you learn about a time in history, it is easy to think that the country is still the 

same today. It is important to understand that Egyptians no longer build pyramids, write with 

hieroglyphs, or have pharaohs that rule the land. Egypt is a modern country governed by an 

elected president, Arabic is the official language, and Muslim is the main religion. Below are 

some facts about the country. 

 

Location  Egypt is in the north east corner  

of Africa 

 Bordered by the Mediterranean Sea 

and the Red Sea 
 

Capital  Cairo 
 

Terrain  Mostly desert 

 The Nile River valley runs through Egypt 
 

Climate  Egypt has two seasons – summer and winter 

 Long, hot, dry summers - short, cool winters  

 Less than 80 mm of rain per year 
 

Agriculture  Less than 3% of the land is arable (able to be farmed or cultivated) 

 Cotton, rice, corn, wheat, beans, fruits, cattle, water buffalo, sheep, goats 

 

Ancient Egypt 

Egypt has an interesting history. Many years ago, pharaohs ruled the land. Read to learn more 

about ancient Egyptians. 

History 

 

 A long time ago Egypt was divided into Upper and Lower Egypt 

 About 3100 BC King Menes fought a war that joined Upper and Lower Egypt 

 King Menes changed Egypt from a tribal society to a state with a central 

government 

 About 400 years later, Pharaohs ruled Egypt 

 The time of the Pharaohs is divided into three main periods which are the Old 

Kingdom, Middle Kingdom, and New Kingdom 

 Egypt was later ruled by the Greeks, Romans, and the Arabs 

In this project, you will take a virtual trip to Egypt. A tomb has 

been uncovered in the Valley of the Kings. You have been asked 

to visit the site. As an Egyptologist, you know about ancient Egypt 

and people are hoping you can help identify the mummy. 

 

Read the facts to become an expert on Egyptian life and beliefs. 

Mediterranean 

Sea 

Red Sea 

Libyan  

Desert 

Western  
Desert 

The Student Workbook 
begins with an introduction 
to the civilization of 
Ancient Egypt. SAMPLE
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Society  There were classes of people in ancient Egyptian society:  

o pharaoh and royal family 

o priests and priestesses 

o nobles and soldiers 

o middle class: scribes, craftsmen,  merchants  

o peasants and slaves 

 

Shelter  Only pharaohs and their families lived in palaces 

 Royal and religious buildings were made from stone blocks cut out of the cliffs and 

hill sides 

 Homes were built from bricks that were made by mixing Nile mud, water, and straw 

and placing the mixture into molds to bake in the sun. 

 Pyramids were not lived in by people - they were used to hold the pharaoh’s coffin 

and items he would need in the afterlife 

 

Dress 

 

 Royalty: traditional kilt or dress, crown and headdresses 

 Priests: long white kilts, white sandals, shaved heads 

 Men: t-shaped tunic under a long pleated kilt  

 Women: long dress or fringed pleated shawl wrapped around the body  

 Children: naked when young but when older dressed like their parents 

 Clothes made from bleached linen, which is made from the flax plant 

 Cloaks worn in winter were made from sheep’s wool 

 Sandals made from leather, papyrus, or palm fronds 

 Men and women wore eye paint 

 Rich women used lipstick and rouge made from red earth 

 Rich women wore wigs and died their hair with powder made from henna 

 Rich people wore jewelry such as necklaces, bracelets, anklets, girdles, rings, 

earrings, and wide collars made of glass beads, gold, silver, pearls, and stones 

 

Jewelry 

 

 Egyptians used metals such as gold to make jewelry 

 Melted over a fire, the metals were cast in clay or sand molds 

 Jewelry was decorated by engraving the metal or adding beads, colored stones, 

or glass 

 Forms of gods, animals, eye of Horus, or other sacred items were made into jewelry 

to protect a person 

 

Furniture  Royal furniture was covered in gold and set with jewels 

 Only the rich had furniture because wood had to be imported from far way 

 The rich had wooden chairs, stools, and chests to hold items such as clothes  

 The rich had beds but most people slept on mud benches covered with mats 

 Food was stored in pots and baskets 

 

For the paperless 
classroom, each 
assignment can be 
viewed as a digital file. 

SAMPLE
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Dishes  Dishes were made from glass, clay, and metals 

 Egypt was one of the first civilizations to make glass  

 Craftsmen made glass dishes by mixing sand and natron 

(salt) in a clay mold  

 Colorful glazes were used to decorate the dishes 
 

 

Tools  Ancient Egyptians made many tools to help them work 

 Tools were made from metal, stone, and wood 

 

 

Entertainment  Ancient Egyptians loved music, singing, and dancing 

 Music was made by flutes, harps, and lutes  

 Board games were played such as Mehen and Senet 

 
 

Hieroglyphs  Oldest form of written language 

 Used picture signs and symbols to represent sounds and ideas 

 Signs and symbols are images of things such as plants, creatures, and objects 

 Hieroglyphs were used for royal or religious text 

 A simpler version called hieratic was used for other writing 

 

Animals 

 

 Egyptians raised cattle, sheep, and goats 

 They used oxen and donkeys to carry items 

 Horses pulled chariots 

 Cats, dogs, monkeys, gazelles, and other animals were kept as pets 

 Cats were sacred and are often shown with gold earrings 

 
 

Values and 

Beliefs 

 

 

Gods  Egyptians believed in gods and goddesses 

 Each god was in charge of something different such as creation, 

healing, or death 

 Sacred animals were used as the god’s body while on earth 

 People believed that if they worshipped gods they would give them 

safety, wealth, and good luck 

 Examples of some of the gods or goddess: 

 
Thoth God of Knowledge 

 
Anubis God of Mummification 

 
Khons God of the Moon 

 
Ra God of Creation 

 
Hathor Goddess of Love and Joy 

 
Seth God of the Desert 

  

Afterlife  Egyptians believed that people lived after their death in the underworld  

  

SAMPLE
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Mummy  Egyptians believed the dead needed their bodies in the afterlife 

 They preserved the body to keep it in good shape for the dead spirit 

 Pharaohs, royalty, and rich people were mummified 

 Poor people were not mummified, their bodies were placed in graves in 

the sand 

 The brain was removed through the nose 

 The lungs, liver, stomach, and intestines were removed and placed into 

canopic jars 

 The heart was placed by the body 

 The body was then covered in natron and wrapped with linen 

 Amulets were put in with the body to protect the dead person 

 A mask was placed over the head and shoulders 

 The body was then placed in a coffin 

 The coffin was placed in a tomb inside a pyramid, temple, or cave 

 Items needed in the afterlife were put into the tomb such as clothes, 

jewelry, furniture, dishes, tools, musical instruments, games, and pets  
 

 

 

 

 

Want to know more about Egypt? There are websites 

bookmarked in the TechnoMummy Favorites folder. Topics 

include Ancient Relics, Facts about Egypt, Fun Games, 

Gods, Hieroglyphs, Photos, Maps, Pyramids, and Tombs. If 

time permits, explore some of the websites. 

TechnoMummy resources 
include a bookmark file of 
websites about Ancient 
Egypt selected specifically 
for elementary grades. SAMPLE
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Assignment 2: The Journey to the Valley of the Kings 
 

 
 

 

Open the Diary Template 

 Open the Mummy folder. 

 Double click on Diary. 

 Click View and choose Edit Document. 

 

 

About the Diary Template 

  

Pharaohs in the Old and Middle Kingdoms built 

pyramids to hold their bodies in the afterlife. 

However, people would steal the items placed in 

the tombs. For this reason, in the New Kingdom 

pharaohs and royalty were buried in secret tombs 

in the walls of the Valley of the Kings. 
 

A new tomb has been uncovered in the Valley of 

the Kings. You must travel to help identify the 

mummy. Write about your journey to the Valley of 

the Kings in your diary. 
 

Using the facts in Assignment 1 and the Internet, 

complete the diary entries. 

Complete the diary entries by adding 

facts where there is grey text. Find this 

information in Assignment 1. 

Use the Internet to find pictures to 

include in your diary. 

Using the provided template to 
create the Egyptologist’s diary: 
 helps to make the writing 

process easier 
 keeps students organized 
 reduces teacher preparation 

 SAMPLE
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Add Facts to a Diary Entry 

 

 Click on the grey text that reads, "Describe clothing appropriate for the climate of 

Egypt". 

 Complete the sentence by typing in what type of clothing you would be wearing. 

 

 Click on the grey area that reads, "What is the climate like in Egypt?" 

 Complete the sentence by typing in a description of the climate. 

 Read over the sentence in the diary. Does it make sense? If needed, change the words 

so it is a complete sentence.  

 

Add a Picture to the Diary Entry 

 

 KEEP THE DIARY OPEN. 

 Open Internet Explorer.  

 Type www.google.com into the address bar and press ENTER. 

 Click on the Images link. 

  

The first sentence in the diary entry tells about arriving in 

Cairo, the capital city in Egypt. What are you wearing? 

 

Read the climate facts in Assignment 1. What should you 

wear based on the climate? 

Add pictures to your diary. Copy pictures 

from the Internet and paste them into the 

Microsoft Word document. The first picture 

you need to find is a map of Egypt. 

Google is the suggested image search engine, 

but you may use another if you prefer. 

SAMPLE
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 Click the mouse in the search box and start to type map of egypt. 

 

 Click on map of egypt. 

 View the results.  

 Click on a picture to enlarge an image. 

 

 

 When you find an image you like, right click on it and select Copy.  

 

 

 

 Click the Word icon in the taskbar. Click to select the Diary document. 

 

 Triple click to highlight the text "Find a map of Egypt…". 

  
Find a map of Egypt and paste it into Diary entry. 

As you type, a list of 

keywords appears 

Illustrated, step by step 
instructions include tool 
icons, sample window 
views, and helpful tips. 

SAMPLE
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 Right click on the selected text and choose Merge Formatting. 

 

 Follow these steps to make the map smaller: 

o Click on the map to select it. 

o Move the mouse pointer to a corner handle. 

o When the mouse pointer changes to a two-way directional arrow,  

click and drag inwards until the map is the desired size. 

 

 

 

 

 

 

Complete the Diary Entries 

 Continue to add facts and pictures to complete the diary entries. In the next session, you 

will format the text and pictures to make it look great! 

 
 

Save the Diary 

 Click the File tab and choose Save As. 

 Go to the place where you save your work. 

 Click Save. 

 

Close Open Applications 

 In Microsoft Word, click the File tab and choose Close. 

 In Internet Explorer, click the Close button in the top right corner of the window. 

 If prompted, click Close all tabs. 

 

Find a map of Egypt and paste it into Diary entry. 

Merge Formatting 

Do not worry about 

arranging the pictures on 

the page. You will do this 

in the next assignment. 

SAMPLE
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Assignment 3: The Diary 
 

 

Open the Diary 

 Go to the place where you save your work.  

 Double click the Diary file. 

 

Make the Words Look Great 

 

 Place the mouse pointer into the left margin area of the document. 

 When the mouse pointer changes to a white arrow pointing to the right, 

 triple click the mouse to select ALL the text in the document 

 Click the Home tab in the Ribbon and find the Font group. 

 

 Click the arrow on the Font command. 

 

 Rest the mouse pointer over a font type in the list. Live preview lets you see what the 

selected text will look like.  

Make your diary look great. Follow the instructions to: 

 format the font, font size, and font style 

 format the pictures to allow text to wrap around them 

 add hieroglyphs to the page 

Follow the instructions to change the 

font, font size, and font style to make the 

words look great! 

SAMPLE
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 Click to choose a font from the list. 

 

 Click the arrow on the Font Size command and select a size from the list. 

 Rest the mouse pointer over a font size in the list. Live preview lets you see what the 

selected text will look like. 

 Click to choose a font size from the list. 

 Click anywhere on the page to deselect the text. 

 Double click the mouse on Monday to select the text. 

 From the Mini Toolbar that appears, click on a style command. Click it a second time to 

remove the style.  

 

Monday 
 

   
BOLD ITALIC UNDERLINE 

 

 Apply your knowledge to make the text look great! 

  

Students are challenged 
to explore Microsoft 
Word tools. 

SAMPLE
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Make the Pictures Look Great 

 

 Click on a picture. 

– Layout Options appear beside the picture. 

 Click Layout Options to see text wrap options. 

 Choose Square. 

 

 

 Place the mouse pointer over the center of the picture.  

 When the pointer changes to a four-way arrow, click and drag the picture to move it to 

a new place on the page. 

 
 

 Continue to change the text wrapping on the remaining pictures in the diary. 

 

  

Right now, the pictures are inline. This means that 

Microsoft Word treats them just like text. By changing 

the text wrapping to square, Word allows the picture to 

move so that the words flow beside it. 

Once you put the picture where you want it, 

there may be a lot of white space on the 

page. To delete the space, click the mouse 

where there is space and press the DELETE key. 

Square 

As they write the diary, students learn 
Word Processing skills including: 
 formatting font, font size, and style 
 pasting a picture into a document 
 formatting text wrapping of a picture 
 resizing and repositioning a picture 

SAMPLE
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Add Hieroglyphs 

 

 Place the cursor at the location on the page where you want to add hieroglyphs. 

 On the Home tab, in the Font group, click the Font arrow. 

 

 Scroll down and select from the following Glyph fonts: 

o GlyphBasics1 

o GlyphBasics2 

o GlyphBasics3 

o GlyphBasics4 

 Type, using the keyboard, to make fun looking Egyptian symbols. 

 

 

Save the Changes 

 Click the File tab, and select Save.  

 

Print the Diary 

 Click the File tab and select Print. 

 Choose the desired printer. 

 Click Print. 

 

Close Microsoft Word 

 Click Close. 

Just for fun, add some hieroglyphs to the 

diary pages. You may want to use the 

Legend of Fonts handout to help you. 

The Glyph fonts are included 
in the TechnoMummy digital 
resources. SAMPLE
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Session 1 Skill Review: Online Picture Scavenger Hunt 
 

 

 

1. Open Microsoft Word and Internet Explorer. 

  

2. Find the following items using the Internet and paste them into the Word document. 

 a) The land in Egypt is mostly desert. The Nile River is surrounded by the Western 

and Eastern desert. Find a picture of the Eastern desert. 

b) In Egypt are many oases. An oasis is a place in the desert where underground 

water comes to the surface, making it possible for food to grow. Find a picture 

of the Siwa Oasis. 

c) In the Old and Middle Kingdom, pharaohs built pyramids as royal tombs. More 

than eighty pyramids of different shapes were discovered in Egypt. King Khufu, 

known to the Greeks as Cheops, built the Great Pyramid. Find a picture of the 

Great Pyramid of Khufu. 

d) Sphinx statues are found all over Egypt. A sphinx is a magical creature with the 

body of a lion and the head of a human, ram, hawk, or other animal. It was 

believed that the sphinx had powers to guard temples and tombs. The most 

famous is the Great Sphinx that sits in front of the pyramids of Giza. Find a 

picture of the Great Sphinx. 

e) Ancient Egyptians have one of the oldest forms of writing called hieroglyphs. 

Hieroglyphs are picture signs and symbols that stand for sounds and ideas. At 

first, people did not understand the writing. Then the Rosetta Stone was found 

in 1799. This stone is a rock slab with the same information written in three 

languages: hieroglyphs, demotic, and Greek. This was used to understand 

hieroglyphs. Find a picture of the Rosetta Stone. 

3. Write a description below each picture. 

  

4. Make the words and the pictures look great! 

  

5. Save the document to your folder as Egypt. 

  

6. Put your name on your work and print it out. 

  

7. Close Word and Internet Explorer. 

Learn more about ancient Egyptians. Follow the 

instructions to copy pictures about ancient Egypt 

from web pages into Microsoft Word. Write a 

description below each picture. 

Skill Reviews are activities 
for students to practice the 
technical skills learned in the 
previous session. SAMPLE
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Sample of Egypt Skill Review 

 

This sample is available in the Session 1 Skill Review folder. 

 

 

 

 

SAMPLE
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Session 1 Extension Activity: Make Your Own Mummy 
 

Make Your Own Mummy 

 

Ingredients: 
 

 1 whole chicken with giblets, from the grocery store 

 5-10 pounds of regular table salt 

 4 jars with lids 

 Modeling clay 

 Box large enough to hold chicken 

 Strips of linen or any other white fabric for wrapping 

 Plastic gloves 

 Optional: beads or charms to represent amulets 

 Optional: scented oils and herbs (mint, thyme, oregano) 

 

Prepare the Materials: 
 

1. Canopic jars can be made from small glass or plastic jars with lids. A canopic jar is the type of 

container used to hold the organs of the body. Ancient Egyptians believed that the dead 

would need these parts in their afterlife. 

 

To make the jars, cover the outside of the container with a thin layer of modeling clay. The lids 

should be built up in the shape of the canopic jars: 

 Man -- liver 

 Baboon -- lungs 

 Hawk -- intestines 

 Jackal -- stomach 

 

2. A sarcophagus can be made from a shoebox. It is a 

coffin used to hold the body. They are usually painted 

with pictures of items the person may need in the 

afterlife. Pictures of gods and symbols were added to 

protect the body. Often the name of the person was written in 

hieroglyphs. 

 

To make a sarcophagus, use a box large enough to hold the chicken. Paint the box in an 

Egyptian style. You may wish to use hieroglyphs to write the mummy's name. (More than one 

box can be used to represent a nested coffin). 

 

3. The mummy is made using the chicken. A mummy is a body that has been preserved using 

salt and wrapped linen. The body of the chicken can represent a pet that has passed away. 

 

Wash the chicken and giblets thoroughly, inside and out. Dry them by blotting with paper 

towels. 

  

Egyptians believed the dead needed their bodies in the 

afterlife. For this reason, the body was mummified. With 

some time and household ingredients, you can 

experience the same process that the priests performed 

when preparing a body for mummification! You will 

need at least a month for the drying-out process. 

WARNING: Always practice 

safe food handling 

techniques. Wash your hands 

before and after handling  

raw food materials. It is best  

to wear gloves during this 

activity! 

Extension Activities at the 
end of sessions provide 
optional enrichment challenges. 

In this activity, a ‘real’ 
mummy is made! 

SAMPLE
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Embalming Ceremony 
 

1. Become an Egyptian: Students may enjoy dressing up like ancient Egyptians. Make costumes 

by wearing white sheets, elaborate jewelry, black eye liner, and sandals. One student may 

wish to take the role of Anubis, the God of Mummification by making a jackal mask. Other 

students can be priests and priestesses. 

 

2. Prepare the Room: A dark room, candle light, incense, and soft music can be used to 

enhance the atmosphere. 

 

3. Prepare the Body with Salt: The washed chicken must 

be thoroughly covered in salt, which is the modern 

equivalent of Natron, which the ancient Egyptians 

used. The salt dries out and preserves the body, so 

that it will not begin to decay. Each student can 

sprinkle some salt on the mummy and say words or a 

spell that will help protect the body. Make sure that 

the chicken is covered with lots of salt, inside and 

out! 

 

4. Prepare the Organs with Salt: use the giblets to represent the four different internal organs. 

They will not be a match, as intestines and lungs are not included by grocers. However, 

typically you will have a heart. The Egyptians left the heart in the body because they believed 

the dead person needed it to be judged in the afterlife. Salt the organs. 

 

5. Continue to Salt the Body and Organs: Every day for the next five or 6 days, two student 

priests should discard the salt, wash off, dry, and recover the chicken and organs with fresh 

salt. As it dries out, the chicken produces liquid, which must be washed away. After the drying 

process begins, the salt can be changed less often. After about a week, you will need to 

change the salt every two days. Then after two weeks, change the salt every three days. The 

chicken will shrivel somewhat as it dries. The drying out process takes about 4 to 6 weeks. This 

is similar to the 70 days that the ancient Egyptians calculated for the drying out process. 

When the allocated time has passed, the chicken and the organs should be dry and free 

from any decay or odor. 

 

 

Wrapping Ceremony 
 

1. Become an Egyptian: Students may wish to dress as ancient Egyptians. 

 

2. Place the Organs in Canopic Jars: Place a final coat of clean salt on the 

organs. Place the organs in the canopic jars for the afterlife. 

 

3. Wrap the Body with Linen: Rip the fabric into thin strips. In turn, each student 

should tightly wrap a strip of linen around the mummy. 

 

4. Add Amulets: Place amulets for good luck inside the wrappings. 

 

5. Add Scented Oils and Herbs: Sprinkle the optional scented oils and herbs on at 

this time. 

 

6. Place the Body in the Coffin: Place the mummy in the prepared coffin. (Use 

more than one box to represent a nested coffin). 

 

This mummy should last indefinitely without decay. Throughout the mummification process, discuss 

how Egyptian beliefs influenced how they treated the dead. 

 

 

WARNING: Always practice 

safe food handling 

techniques. Wash your hands 

before and after handling  

raw food materials. It is best  

to wear gloves during this 

activity! 

SAMPLE




